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Collaborative Editorial Workflow 
The Adobe InCopy CS4 and  
InDesign CS4 Workflow

Executive overview

Effective publishing demands tightly choreographed collaboration among editorial 
groups and design groups working against ever-present, urgent deadlines. With a more 
efficient workflow, editorial and design professionals can devote more time to the qual-
ity of the work and less to the mechanics of the publishing process.

Regardless of company size, a large number of publications are created by small, tightly 
knit teams of editors and designers. Publications created by fairly small workgroups 
need an efficient workflow, but often make do with a combination of Microsoft Word, 
a page layout application, and many rounds of paper proofs. Because these tools and 
techniques are not designed for tight collaboration, combining them in editorial work-
flows often leads to delays, inefficient workarounds, and compromised quality. 

Adobe® InCopy® CS4 is a professional writing and editing program that integrates 
tightly with Adobe InDesign® CS4 to deliver a complete solution for collaborative edi-
torial workflow for any size publishing workgroup. 

InCopy CS4 lets writers and editors simultaneously develop their individual stories 
directly in the InDesign CS4 layout, even while the designers are working on the same 
layout in InDesign.  Because InCopy CS4 and InDesign CS4 use the same technology 
for composing text and displaying graphics, writers, editors, and designers can visual-
ize exactly how copy and layout interact—throughout the workflow, rather than just at 
the end.

This paper explains how using InCopy CS4 and InDesign CS4 together reduces review-
and-revision cycles between editors and designers, improves editorial control over 
copy, and gets publications to market faster. It also provides a step-by-step overview 
of how to set up an effective InCopy CS4 workflow that’s easily customized for your 
workgroup’s needs.
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Collaborative editorial workflow:  
Bridging the gap between editorial and design

An ideal workflow enables everyone to focus on his or her own work without being slowed 
down, rushed, or hindered by others. However, publishing teams often devise an approach 
to working together that is less than ideal.

Conventional publishing workflows: linear and iterative
Many of the challenges faced by smaller publishing workgroups stem from the lack of an 
integrated workflow solution. They combine word processing and page layout applica-
tions from different vendors instead. Although both types of applications are well suited 
for their respective purposes—developing copy and designing pages—they are not well 
suited for seamless collaboration. In particular, writers and editors cannot see copy in the 
context of a layout until it is placed in the page layout application. Once it is, they can no 
longer work on it directly. Neither editorial nor design has an easy way of assessing pre-
cisely how their work will come together: how the copy will fit the layout, or how images 
and other design elements will complement the copy. To solve this problem, various work-
arounds have become standard practice.

These workarounds often include numerous hard-copy proofs marked up by editors and 
submitted to the designer, who then makes the required changes in the layout. This editing 
cycle can repeat itself multiple times, resulting in additional material costs, and perhaps 
more importantly, a significant decrease in efficiency and job satisfaction.

Conventional linear workflow

Copy 
to proof

2nd layout 
proof

Final 
copy

nth layout 
proof

Final layout 
for printer

Copy 
to edit

1st layout 
proof

?

Content is developed “blind” with respect to the pub-
lication’s layout file. Only after the layout proofing 
rounds begin can editors fix copyfitting problems. 

Editors lose direct control of the editorial process, and designers are forced to serve as 
their eyes and hands. Frustration can be high, errors are common, and quality may suffer.

If editorial and design proceed concurrently, without the right collaboration tools in place, 
editorial may produce copy that’s too long, too short, or poorly suited to its visual context; 
design may produce layouts and graphics that don’t complement the copy, or they lose pre-
cious time re-formatting content when stories are updated; and editors may hover next to 
designers making over-the-shoulder copy corrections. 

The InDesign CS4 and InCopy CS4 workflow: concurrent and collaborative
Implementing an InDesign CS4 and InCopy CS4 workflow transforms this process by 
making it easy to work with copy and design together.  

Using InDesign CS4, the designer makes layout content editable to InCopy users by 
putting individual spreads or the complete document on a networked file server. Using 
InCopy on their local computers, one or more editors can open this file from the server at 
the same time, editing their stories within the layout, without having to wait for a printout 
to wend its way to them. 

As editors save changes to stories they’re editing in the layout, the system keeps everyone 
else who’s working on the publication up to date with their revisions.

Since InCopy users are working in the live layout file, they can “write to fit” (or edit to fit) 
from the start, dramatically reducing the number of proofing rounds required. 

A Cross-Platform Solution
Windows InCopy CS4 flawlessly opens InDesign 
CS4 files created on a Macintosh, and vice versa. 

Macintosh™ OS 
Windows™ OS

Macintosh™ OS 
Windows™ OS
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InCopy CS4 and InDesign CS4 parallel workflow (simple overview)

Shared layout  
and content  

on server

INDESIGN

Designer

INCOPY

Writer

Editor

Proofreader

Final layout 
for printer

The designer places the InDesign layout on a central 
file server. Text and image frames in the layout are 
assigned for review and editing to a contributing 
member of the editorial workflow. Multiple InCopy 

users can open spreads and edit content from the 
same layout file concurrently while it’s on the server, 
even if the designer has it open in InDesign. 

However, to protect the integrity of the design, InCopy only allows editors to edit the 
contents of text and image frames which the designers have designated as editable in the 
layout. Editors cannot change page geometry (move or resize frames, add or delete frames 
or pages, apply text wrap, etc.). While they can apply local text formatting and any text 
styles the designers created and saved with the layout to their stories, editors cannot add, 
delete, or modify any of the styles. If the designer is working on the same layout concur-
rently and saves changes to it in InDesign, any editor who has it open in InCopy is notified 
that the design is out of date. Choosing File > Update Design in InCopy immediately 
refreshes the layout to reflect the latest state of the publication, without losing any of the 
InCopy user’s edits.

When the editors have completed the final touches to their stories, and the designer has 
updated all the InCopy content in the layout, the file is ready for preflighting and handoff 
to a commercial printer.

Off-the-shelf  
InCopy CS4 and  
InDesign CS4

Third-party developer 
solutions that add 
structure and features 
to  the  InCopy and 
InDesign workflow

Enterprise-level pub-
lication production & 
management systems 
from systems integra-
tors with InCopy and 
InDesign at their core

Cost of entry Low Moderate High

Workgroup size 
(per publication)

2–15 5–30 15–100+

Technology 
infrastructure

Folders and files on a 
networked file server

File server or simple database 
running on the file server

High-end database running on 
a dedicated database server

Customizable UI Yes May be enabled May be enabled

Extensible Minimal Minimal High

Support services Standard Varies High

More information www.adobe.com/incopy http://partners.adobe.com/ 
public/asn/partnerfinder/ 
developer/index.html

www.adobe.com/products/ 
incopy/integrated.html

Selecting the right implementation of InCopy
Large publishing workgroups tend to invest 
in highly structured workflows supported by 
features such as automatic routing, user roles, and 
database reporting. Because smaller workgroups 
don’t need this kind of structure, InCopy CS4 
paired with InDesign CS4 provides a simple, 
flexible solution that enables team members to 
work in parallel without interfering with each 
other’s work. The basic InCopy CS4 and InDesign 
CS4 workflow is ideal for project teams of 2 to 15 
people, such as small to mid-size book publishers, 
weekly newspapers, corporate communications 
teams, and monthly magazine publishers. Consult 
the table for guidance on selecting the right way 
to integrate InCopy based on the size and com-
plexity of your organization.

A Powerful Tool for Editors
InCopy CS4 delivers an impressive array of power-
user tools in a user-friendly package. Here is a 
brief overview:

Parallel Workflow: Accelerate production by 
working simultaneously instead of in sequence. 
Designers can work on an InDesign document 
while writers edit the same document’s text in 
Adobe InCopy, without fear of overwriting each 
others’ work.

Page Visualization: Write and edit to fit the lay-
out precisely. View accurate feedback on the sta-
tus of copyfitting, line endings, and hyphenation, 
or simply view a story as it appears on the original 
page layout. Writers are notified of changes to the 
InDesign layout so they can copyfit as needed to a 
changing design.

Productivity: Meet deadlines more efficiently 
using editorial features such as a powerful Find/
Change command; extensive paragraph, charac-
ter, and table styles; and support for rapid editing 
and formatting using only the keyboard.



4InCopy CS4 Workflow

Moving to an InCopy CS4 workflow

Making the transition to an InCopy workflow is surprisingly easy and flexible. InDesign 
CS4 contains all the tools necessary for design and production staff to participate in 
the workflow, so all that’s needed is to install InCopy CS4 on the editorial workstations. 
InCopy can be flexibly integrated into any stage of the editorial process. An editor may 
begin composing a story directly in InCopy (in a standalone InCopy file or an empty 
placeholder text frame in the layout file), or may choose to import finished content created 
in Word, and use InCopy only for late-stage copyfitting in the layout. 

Publishers with a local network file server can choose to implement a layout-based 
workflow, an Assignment-based workflow, or a combination of the two. To accommodate 
off-network InCopy users, or if no local server is available, remote workflows can be set 
up with e-mail–based Assignments. These options, detailed below, allow publishers to 
customize the workflow based on the speed of the local network, the size of the layout files, 
the number of editors involved in the same project, and whether users are on- or off-site.

Layout-based Workflow. The most straightforward way to implement an InCopy work-
flow is to place the InDesign layout file (.indd) on a local network file server and have all 
publication staff work with it directly off the server. (This works best with small layout 
files.) Designers open the file over the network in InDesign. Editors and writers open the 
InDesign layout over the network with the File > Open command in InCopy, allowing 
them to see and edit their stories “live” in the actual layout. One InDesign user and one or 
more InCopy users may open and work on the same layout file concurrently. 

A typical InDesign layout file is read-only when opened in InCopy. To make content edit-
able for InCopy users, the designer needs to export the layout’s text and image frames to 
InCopy format (.icml) files, saving these on the server in a project subfolder. The layout’s 
content is now linked to the exported files. Editors can open the layout in InCopy and edit 
the content in the linked frames. A built-in check-in/check-out system prevents more than 
one user from editing the same content in the layout at the same time.

Layout-based workflow

InDesign layout and 
linked content files on 

network server

InDD

ICML

C BA

AB
C

Writer

Editor

Proofreader

AB
C

AB
C

AB
C

INCOPY

Designer
(opens layout from server)

AB
C

INDESIGN

 open over the network        linked files

Final layout 
for printer

Assignment-based Workflow. Assignment (.icma) files are subsets of full InDesign layout 
(.indd) files; often containing only one or two spreads from a much larger InDesign docu-
ment, and so are faster to open over the network. Even if network speed is not an issue, 
assignments allow the designer to provide each editor with a single document containing 
only the content for which they are responsible. 

Ada’s four pagesJoe’s two pagesMary’s six pagesFull InDesign layout

INCOPYINDESIGN

Multiple InCopy assignment (.icma) files can be cre-
ated and managed from a single InDesign layout file.  

Here the designer has exported three assignments, 
one for each of the editors working on the publication.

Understanding linked content (.icml) files 
Most content in an InDesign layout file is 
contained in a text or image frame. Designers 
create these frames, position them on the page, 
and fill them with text or graphics using InDesign 
tools. Some frames may be empty “placeholders,” 
awaiting content.  

In the InCopy CS4 workflow, designers can export 
the formatted contents of any text or image 
frame, or even an empty one, to an external 
InCopy (.icml) file. This creates a dynamic link be-
tween the .icml file and the content in the source 
frame in the layout (.indd) file. 

Only the contents of linked frames (those that are 
linked to external .icml files) are editable by 
InCopy users. Other frames’ content that the de-
signer did not export, such as page folios, are vis-
ible in the InCopy layout view, but are not editable.

InDD InDD

ICML

C BA

AB
C

ICML
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Using the InDesign Assignments panel, the designer sets up assignment files by exporting 
to a new assignment the text and image frames for a specific editor. InDesign automati-
cally creates Assignment and Content subfolders in the layout’s project folder on the 
network file server. It saves new assignment (.icma) files in the Assignments subfolder, and 
from the frames selected by the designer, it exports linked InCopy content (.icml) files to 
the Content subfolder. Each editor opens their own assignment file in InCopy to edit their con-
tent. The same check-in/check-out system prevents the designer from modifying a frame’s 
content while an editor is working on it, and vice versa.  

INCOPYINDESIGN

Final layout 
for printer ICML

ICMA

C BA

Designer
(layout may be local as 

shown, or on server)

A

Assignment-based workflow

InCopy Assignments and linked  
content  files on network server

Proofreader

Editor

A

C

C

Writer

B

B

A

 open over the network        linked files

Remote Workflow. If an editor is off-site and cannot access the file server, or if a publishing 
team doesn’t have access to a central file server, InCopy can be used remotely. This solu-
tion requires the use of Assignments (see above) for any editor who is working remotely, 
even if the workgroup is using a layout-based workflow locally. 

After creating an assignment for an editor, the designer chooses the Package For InCopy 
command in InDesign, which creates a single compressed .icap file that can be e-mailed 
to the editor or uploaded to an ftp server. The package file contains everything an InCopy 
user needs to view the layout and edit content within it, including the assignment file and 
all the linked content files associated with it. When the designer packages an assignment, 
the system also checks out all the content on the remote editor’s behalf, preventing local 
users (including the designer) from editing the content while it’s being worked on by the 
off-site editor. 

ICMAInDD

AB
C

AB
C

Remote workflow (email-based Assignments)

Remote 
editor

1.   Designer creates an Assignment, and 
then e-mails an InCopy Assignment 
package (.icma and .icml files) to editor.

3.   Editor creates an InDesign Assignment 
package with updated content and 
e-mails it to designer.

4.   Designer opens 
package; InDesign 
automatically updates 
layout’s content with 
editor’s changes.

2.   Editor opens package, 
edits content in InCopy 
assignment, and saves 
changes.

Designer

ICAP

INDESIGN INCOPY

IDAP

When the remote editor opens the packaged assignment on his own computer, the file 
automatically unpacks itself, opening the Assignment file in InCopy and allowing the 
editor to edit its content. When the editor is finished, he can use the same procedure for 
packaging the assignment and modified stories into a single file and sending it off, either 
to another editor as an InCopy Package (.icap) or back to the designer as an InDesign 
Package (.idap). When the designer receives and opens an InDesign Package file, it auto-
matically unpacks itself, checks the content back in, and allows the designer to update the 
layout with the editor’s changes. 

About file types
The InCopy CS4 workflow entails working with 
three main types of files and three others that are 
used in special situations. Each type has its own file 
name extension to distinguish among them in the 
operating system, in the InCopy CS4 Story bar, and in 
InCopy CS4 and InDesign CS4 status messages.

INDD The InDesign layout, containing a 
mix of native, embedded, and linked 
page elements in frames. 

ICML A file containing the contents of 
a text or graphics frame exported 
from the InDesign layout to InCopy 
format, known as a “linked content 
file” because it’s linked to the layout. 

ICMA An InCopy assignment file, contain-
ing page element previews from a 
subset of the InDesign (.indd) file 
and full editorial access to the linked 
content (.icml) in the text and image 
frames the designer associated with 
the assignment file.

ICMT An InCopy template for a standalone 
.icml file.

ICAP An InCopy Package file used in 
remote workflows, containing an 
assignment (.icma) file and its associ-
ated linked content (.icml) files.

IDAP An InDesign Package file used in 
remote workflows, it contains an 
assignment (.icma) file and its associ-
ated managed content (.icml) files.
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Step-by-Step InCopy CS4 workflow examples

Chicago Wilderness magazine: Current issue
Chicago Wilderness is a 124-page full-color quarterly magazine. It offers its outdoor enthu-
siast subscribers in-depth articles about Chicago-area wilderness destinations, news about 
nature conservancy efforts, and colorful wildlife photography. 

In this step-by-step scenario, a designer named Peter, a writer named Kate, and a copyeditor/
proofreader named Gina are working on the Fall 2010 issue. Since the InDesign layout is 
a single 124-page file on the server, too large for the editors to comfortably open and work 
on over the network, Chicago Wilderness uses an Assignment-based workflow. Kate will 
write copy for the feature on restoration efforts at nearby Wolf Lake. Peter, the designer, 
needs to create an InCopy Assignment for her that includes all the elements in the article.

Set up an assignment in InDesign
1. In InDesign, on the four pages in the layout allotted for the Wolf Lake feature story, 

Peter roughs out a design with images and placeholder text frames, and then selects 
frames from the first spread and drags them on top of the New Assignment icon  
at the bottom of the Assignments panel. He names the assignment “Wolf Lake” and 
clicks OK (see sidebar at right). InDesign automatically saves this file in the project’s 
assignments folder, CW_Fall10 Assignments, which it created and named based on the 
name of the InDesign layout. The exported ICML files, one for each content frame Peter 
included in the assignment, are automatically saved to a Contents folder within the 
CW_Fall10 Assignments folder. 

The first spread of Kate’s feature article on Wolf Lake. The frame at the top right, and the series of threaded 
frames (comprising a single story) at the bottom, have been exported to incx ICML format and associated with 
Kate’s assignment. You can see the names of the two linked incx ICML files in the Assignments panel in InDesign. 

2. On the second spread reserved for Kate’s feature, Peter adds the remaining frames to 
Kate’s assignment by dragging and dropping them onto the Wolf Lake entry in the 
Assignments panel. He chooses Update Selected Assignment from the Assignments 
panel menu and alerts Kate, the writer, that the assignment is ready for her to work on.

Write and edit content in InCopy
3. In InCopy, Kate opens the Wolf Lake.icma file from the CW_Fall10 Assignments folder 

on the server. The assignment file is much smaller than the InDesign layout because it 
includes only the two spreads containing her story frames, and not the entire 124-page 
layout. Kate selects the name of the assignment in her Assignments panel and clicks the 
Check Out icon  at the bottom of the panel to prevent others from editing the same 
stories while she’s working on them. She begins writing the main feature story.

A B C

A. The Assignments panel in InCopy lists the editable content in the active file.  B. Before she can begin writing, 
Kate checks out the stories by selecting the name of the assignment and then clicking the Check Out icon at the 
bottom of the panel.  C. The pencil icons confirm the checkout.

About assignment options
An assignment includes an assignment name, the 
InCopy user who will work on the assignment, 
and a color for identifying assigned frames in 
InCopy and InDesign. Additional controls deter-
mine how much context a writer or editor sees 
when working on an assignment:

•	Placeholder	Frames creates an assignment 
that includes all spreads containing assigned 
frames. However, only assigned frames display 
their text or graphics content and can be 
checked out; all other frames appear empty. For 
writers and editors who prefer to focus exclu-
sively on their content, this option eliminates 
nonessential information.

•	Assigned	Spreads creates an assignment 
that includes all spreads containing assigned 
frames. All frames—not just assigned frames—
display their text or graphics content. However, 
only assigned frames can be checked out. This 
is the default option.

•	All Spreads creates an assignment that includes 
all pages and spreads regardless of whether 
they contain assigned frames. However, only as-
signed frames can be checked out. This option 
lets writers and editors see their work in the 
context of the entire InDesign layout.

Michael S. Witherell
Rectangle

Michael S. Witherell
Rectangle
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4. As she works, Kate switches among one of the three page views in InCopy CS4: Layout, 
Story, and Galley. When she just wants to get the words down on “paper,” she uses Story 
view. When she wants to see line breaks and line numbers, she chooses Galley view. 

Story and Galley view, easily accessible by tabs at the top of the window, show the editable text content 
(including overset text) of the current InDesign layout or assignment in one scrolling window, without 
distracting text formatting and surrounding page elements. Story view (left) flows text to the edge of the 
window, as in Word. Galley view (right) includes line numbers and stays true to the layout’s line breaks (note 
the short caption lines). Gray story bars separate individual stories.

 When she wants to see her words in context with the design, Kate works in Layout view. 
Text formatting, image wraps, footnotes, page jumps, folios, background colors, and 
other page elements are exactly as they appear in InDesign. Kate can zoom in (up to 
4,000 percent) for close-up work of text set in small type sizes, or zoom out for an over-
all look at multiple spreads at once. 

The InCopy CS4 Layout view in normal mode (left) shows nonprinting frame edges, ruler guides, bleeds, 
the pasteboard, and content status icons. Page elements that are not editable are screened back. Switch to 
Preview mode (right) to see an accurate print preview of all content in the layout. Content can be edited in 
either mode.

 Regardless of which view Kate’s working in, the Copyfit Info panel keeps her up to date 
with her progress. If her text exceeds the amount of space allotted to the story in the 
layout, she can access the overset copy in Galley or Story view and edit to fit.

The Copyfit Info panel provides continuously updated statistics on the current story’s word, line, and charac-
ter count and its column depth. A visual and numeric indicator also tracks underset or overset status. 

Update design in InCopy
5. While Kate is working on the Wolf Lake feature story, Peter (the designer) continues 

to work on the magazine layout in InDesign, creating and designing other pages. He 
has just learned that there will be one more image in Kate’s feature, so he has to modify 
other elements to make room. While he cannot edit the contents of the frames Kate has 
checked out, he still has full control over the page geometry and can add, remove, and 
resize elements. He places an image on top of the main body of her story, and turns on 

Icon Name Location

Available
Assignments panel, text 
frames, and graphic 
frames

In Use by (name)
Assignments panel, text 
frames, and graphics 
frames

Editing
Assignments panel, text 
frames, and graphics 
frames

Available and 
Out of Date

Text frames and graphic 
frames

In Use by (name) 
and Out of Date

Text frames and graphic 
frames

Assignment or 
layout 
Out of Date

Assignments panel

Text Content 
Out of Date Assignments panel

Text Content 
Up to Date Assignments panel

Graphics Content 
Out of Date Assignments panel

Graphics Content 
Up to Date Assignments panel

Simple access control and synchronization
Straightforward check-in and check-out of linked 
content frames prevents a co-worker from editing 
a story you’re currently working on, and keeps 
everyone informed as to who is working on which 
content at any given time. Easy-to-spot visual indi-
cators (such as the Out Of Date symbol) in InCopy 
and InDesign alert you when a colleague working 
concurrently on the same document has modified 
content or page geometry, or has checked out a 
content item. Modified items can be brought up 
to date with a simple click. 

Workflow status icons



8InCopy CS4 Workflow

Text Wrap so it pushes Kate’s text to either side of the image instead of overlapping it. 
Peter chooses Update Selected Assignments to alert Kate to the change.

In InDesign, the crossed-out pencil icons on text frames (and their equivalents in the Assignments panel) tell 
Peter that someone has checked out the content to work on it. When he hovers his cursor over an icon, a tool 
tip appears with the name of the user who checked it out and other details. Peter cannot edit the contents of 
a frame another user has checked out, but he is always able to change its page geometry in InDesign. 

6. In InCopy, Kate notices the alert  in her Assignments panel that the assignment 
itself is out of date. She chooses Update Design from the panel menu to see Peter’s latest 
changes to the page geometry. Fortunately, the copy she has written for the main story 
still fits, even with the new image forcing the text to wrap around it. She continues work-
ing until she is finished with the main body, saves her changes, and turns her attention to 
the pull quote on the last page.

Update copy in InDesign
7. In InDesign, Peter sees an Out Of Date icon  appear on the Wolf Lake text frames 

and next to the entry for the story in his Assignments panel, alerting him that Kate 
saved her edits, and now the content he sees in her feature is out of date. Peter selects the 
story’s entry in his Assignments panel, and then clicks the Update Content button  at 
the bottom of the panel to review Kate’s finished copy. He is glad to see she was able to 
accommodate the last-minute change.

8. When Kate has completed all the copy for the feature story, she closes the Assignment 
file. InCopy alerts her that she still has some of the content checked out, and offers to 
check it in for her. Kate clicks OK to have InCopy save any unsaved changes and check 
all the content back into the workflow. Peter now has all of Kate’s updated content, and 
he completes the layout for the Wolf Lake feature story. Next, it’s Gina’s turn to copyedit 
and proofread. Using the Assignment Options dialog box in InDesign, Peter reassigns 
the Wolf Lake assignment to Gina and notifies her that it’s ready. 

Copyedit and proofread in InCopy
9. In InCopy, Gina opens the Wolf Lake assignment and checks out all of its content by 

clicking the Assignments panel’s Check Out icon . She reviews the stories for poor 
hyphenation, bad line breaks, and widows and orphans, confident that what she sees in 
InCopy precisely matches the InDesign layout. 

Working with Tracked Changes
 10. Before she makes any edits to the file, Gina chooses Enable Tracking In All Stories from 

the Changes menu in InCopy. This allows Kate to review Gina’s suggested corrections to 
the copy before accepting or rejecting them, which she can do one-by-one or all at once. 

Finish up in InDesign
 11. By this time, all the writers have checked in all the stories from the assignments they 

had open, and Gina has reviewed them all. Peter updates all content, makes a few last-
minute refinements, and then proceeds with his normal preflighting routine in prepara-
tion for creating a press-ready PDF file from the InDesign layout. 

the results: With the InCopy/InDesign workflow enabling them to work concurrently 
in tight collaboration, the Chicago Wilderness team has shaved considerable time off their 
magazine production schedule.

Using Track Changes
Turn on Enable Tracking in InCopy to record 
edits made by every user to a story, including 
designers. View the change markup in Galley 
view or Story view and then hide, show, navigate, 
and accept or reject changes. You can also track 
changes across multiple stories, customize the 
way tracked changes are displayed onscreen, and 
print out the tracked changes markup.

Story view shows tracked changed mark-up (top), and 
the Change Info panel reveals details of each specific 
change (bottom).
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Chicago Wilderness magazine: Upcoming issue
The next example demonstrates how editors can benefit from the InCopy workflow at any 
point in the process, even before an InDesign layout is ready for them. In this scenario, 
Robert, another writer on the Chicago Wilderness editorial team, wants to begin work-
ing on a two-page review of Goose Lake Prairie, a popular regional destination. Goose 
Lake Prairie is one of the four places slated to be reviewed in an upcoming issue’s periodic 
reviews section, “Into the Wild.” By specifying a few basic settings in a standalone InCopy 
file, Robert can get a head start on his review, and be confident that it will fit the InDesign 
layout that Peter will create in a few short weeks.

Set copyfitting parameters in InCopy
1. Robert creates a new InCopy document. In the New Document dialog box, he clicks 

the Document Preset menu and chooses the Into the Wild preset that Peter helped him 
prepare earlier. The preset specifies the page size and the main content area’s width and 
target word count. If he preferred, he could enter a target line count, page count, or 
column depth using any available measuring unit. 

The New Document dialog box in InCopy lets you define a target  story length. Newspaper writers may 
prefer to set a target column depth in any unit of measurement, including agates.

 Because styles affect copyfit, Robert uses commands in InCopy to load selected para-
graph, character, and table styles from the InDesign layout of the most recent Into the 
Wild section, ensuring his InCopy text formatting will be the same.

Because InCopy and InDesign share a text composition engine, writers are assured that the formatting and 
styles they apply to text in InCopy will be honored in the InDesign layout file. 

2. Now Robert is ready to write. He prefers to start in Story view, putting words down 
quickly as they come to him. Since the InCopy file is not linked to any InDesign layout 
yet, he understands that the Layout view won’t show him his story in context of other 
elements on the final designed page. Nevertheless, as he’s further along, Robert occa-
sionally switches to Layout view to ensure that he’s applied the correct paragraph and 
character styles and to see how the text will appear in its final column width. 

While the Info column in Galley or Story view (left) lists the names of the styles applied to paragraphs, only 
Layout view (right) shows text in its formatted state. 

InCopy CS4 for Web and xML Workflows
In addition to print publications, InCopy CS4 can 
streamline content creation for websites and 
other distribution methods involving xML.

Both InDesign CS4 and InCopy CS4 allow users 
to create xML tags and apply them to text selec-
tions. Tags are maintained in the text flow during 
all check-in and check-out procedures as a file is 
being collaboratively produced. The current xML 
structure of a file can be previewed and edited in 
either program’s Structure pane. 

InCopy CS4 can open xML files and convert 
them to standalone InCopy (.icml) files, as well as 
export a story to xML format.

Click a tag in the Tags panel (top) to apply it to 
selected text. In Layout view (middle), tagged text is 
surrounded by nonprinting brackets. Tags are easier 
to see in Story or Galley view (bottom) and may be 
hidden by the user for readability.
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 As Robert writes, he keeps his eye on the Copyfit Info toolbar, which provides a word 
count and other indications of how well his copy will fit its eventual hole in the layout.

Since Robert specified a target word count of 1,250 in the New Document dialog box, the Copyfit Info toolbar 
informs him that he’s 243 words short at this point (note the current word count of 1,007 on the left).  

Working with notes
3. From time to time, Robert wants to keep alternative text close at hand until he decides 

which version he prefers. He selects the alternative text and presses the F8 key to convert 
it into an inline note. Occasionally he inserts a new note from the Notes menu, and 
enters in comments or questions for Peter or Gina. He can use the Notes panel to show 
or hide notes and quickly skip from one note to the next.  

Inline editorial notes let designers and editors communicate with each other in the context of the copy. 
In Layout view, notes appear as nonprinting icons (top right) which can be revealed in the Notes panel 
(bottom right). 

Working with tables
4. In the Into the Wild section, every review of an area destination includes a small table 

listing the area’s contact information, activities, website address, and other information. 
Robert copies the information from an e-mail and pastes it into the text flow, and then 
uses the InCopy table features to convert the tabbed text into a table and format it. 

Powerful table functions allow users to easily convert raw tabbed text (top left) or tables placed from Word 
or Excel into elegantly formatted tables (center). Settings for stroke color, alternating background fills, and 
text styles can be specified in a table style and applied with a single click. 

 Finally, when he has completed his review of the Goose Lake Prairie nature reserve, 
he saves the InCopy document into a folder, called “Incoming Copy,” that Peter (the 
designer) created on the server. It holds new standalone stories that are ready to be 
placed into the InDesign layout. 

Placing a standalone InCopy file in an InDesign layout
5. Peter begins working on the layout of the upcoming issue. He adds pages for the Into the 

Wild section, and places Robert’s ICML file  into text frames on the Goose Lake Prairie 
review spread, which automatically links the frame to the ICML file. Peter continues to flow 

Printing	and	Exporting	to	PDF
Some InCopy users find it difficult to edit on-
screen, preferring to review paper proofs and 
mark them up as in a traditional workflow. This is 
easy to do in InCopy CS4. Of course, in this work-
flow, it’s usually the InCopy users themselves who 
then apply their handwritten edits to the actual 
text onscreen. 

Editors are offered a lot of choices in the Print 
dialog box. They can print the full layout as single 
pages or as spreads, with images or without. 
They can also print out either galleys (with ac-
curate line breaks) or text content as seen in Story 
view, and choose the typeface, font size, and line 
spacing they prefer, even if it’s not what they use 
onscreen. Story and Galley printouts can option-
ally include inline notes and tracked changes.  

Adobe Acrobat is not required to create a PDF 
from InCopy; a custom PDF engine is part of the 
program. To make a PDF of a layout or an assign-
ment, editors use the File > Export command 
and choose Adobe PDF from the Format menu. 
PDF export options are nearly identical to Print 
options (e.g., PDFs can be made from the Layout, 
Story, or Galley view), with a few additional 
features. One of these is the ability to convert 
inline notes to annotations (“comments”) when 
exporting the Layout view to PDF, something not 
even InDesign CS4 can do.



11InCopy CS4 Workflow

the story, threading the text from one frame to the next. Robert had already formatted the 
text with the styles he’d imported, and matched the column width, so it fits perfectly. Peter 
cuts the table from the story flow and pastes it into a new text frame so he can position it 
elsewhere on the spread, and then adds images and illustrations to the article.

Robert’s text, flowed into the InDesign layout, fits perfectly. While it’s not required that writers 
apply formatting to InCopy text—they can leave that task to the designer—doing so helps them to 
achieve the essential task of accurately gauging copyfit, and also helps streamline the production 
workflow.

  Peter knows Robert will need to review the complete article, so he creates an InCopy 
assignment that includes the main story as well as the title, table, images, and captions. 
After InDesign saves the assignment and the new linked content files to the project folder 
on the server, Peter notifies Robert that the layout is ready for him to review.

6. Robert opens the new assignment, checks out the content, and makes minor line break 
adjustments to smooth the rag of the text that wraps around the images.

Working with images in InCopy
7. At Chicago Wilderness, writers and editors have some control over the images that 

accompany their stories. Knowing this, Peter made sure to export the inline images he 
had placed to InCopy format and include them in the assignment so that Robert could 
make minor adjustments to them as he sees fit. InCopy users cannot modify image 
frames, just the image contents.

After checking out the Boot image, Robert uses the Position tool in InCopy to select it and move it around in 
its frame. He uses the Transform commands for more control, or to quickly flip the image’s horizontal orienta-
tion, as shown here.

8. When Robert is satisfied with the Goose Lake Prairie spread, he checks the files back in 
so that Peter can assign them to Gina for copyediting and proofreading.

the results: By using InCopy CS4, writers and editors can work ahead of the publication 
schedule as their schedule permits. Robert’s preparatory work in styling and copyfitting 
his standalone Goose Lake Prairie review enabled the team to skip a number of proofing 
rounds that would normally be required in a traditional, linear workflow. 

InCopy or InPhoto?
Even with the restriction of not being able to 
reposition or resize image frames, InCopy users 
have a number of options when editing the 
contents of those frames, assuming the designer 
exported them to InCopy format (otherwise, all 
images are read-only in InCopy). 

After checking out an image frame in the layout, 
InCopy users can scale the image contents to 
adjust the crop. They can rotate, shear, and flip 
the image inside the frame, and if it’s a layered 
PSD, PDF, or AI file, change which image layers are 
visible.  Editors can modify the image itself if they 
have the right software installed, or can even 
import a different image, replacing the one in the 
frame, using the File > Place command.

Some publishers have found it helpful to install 
InCopy CS4 on their photo editors’ workstations. 
Designers create InCopy assignments for them 
comprised of placeholder image frames, allowing 
the photo editors to work with images in the 
layout, just as editors work with text in the layout.
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parallel Collaborative workflow

E-mail–based Assignments Easily assign stories and graphics as a single assignment package to send to any 
external contributor via e-mail. The package contains all information needed to 
update the layout with the added or edited content.

Automated File Management Create and edit assignments without worrying about the location of the files 
in the assignment.  Creating an assignment auto-creates a folder that holds the 
assignment’s stories and graphics. Moving an article to a different assignment auto-
matically moves the article’s file to the appropriate folder. 

Assignments Panel The Assignments panel is the hub of the InDesign and InCopy workflow. View and 
manage the status of assignments, arrange story order, select multiple items, and 
unlink stories in one central location. 

Save Story Order Change the sequence of stories in an assignment to match an organization’s working 
style.

Track Changes Track changes to text for improved editorial control.  View all edits made to a story, 
and accept or reject any edit as you review the text.

Inline Editorial Notes Improve collaboration with inline notes that maintain their position within the text 
and are visible in both InCopy and InDesign.

Flexible Graphics Placement Easily place, scale, crop, and rotate images and artwork, including inline graphics, 
in frames assigned to editorial staff.

Output to Print or Adobe PDF Print from InCopy CS4 to edit hard copy or export one or more stories at a time to 
Adobe PDF, setting options such as font subsetting or including accurate line end-
ings, inline notes, and styles.

page Visualization

Layout, Story, and Galley views Edit copy in the view that best fits the current task. Layout view shows you exactly 
how stories appear in the InDesign layout and allows you to edit or write in context.  
Story view displays text in a pure word processing view. Galley view includes line 
numbers and provides accurate story and line breaks.

Instant Layout Refresh Refresh the Layout view whenever your designer sends you design changes for ref-
erence as you edit.

Standalone Copyfit Begin assigning or writing copyfitted text as soon as available space is known, even 
before pages are designed. Define a copyfit area by specifying a column width, col-
umn depth, and available styles.

Copyfit Status Indicator Color-coded feedback via the Copyfit Info toolbar provides up-to-the-minute feed-
back on copy length.

Multiple Measurement Units Multiple measurement units include agates for newspaper publishing.

Vertical Depth Ruler Budget space for stories more accurately using the vertical depth ruler found in the 
margin of the Story and Galley views, which reports a story’s depth using the active 
unit of measure.

Quick Reference: InCopy CS4 and InDesign CS4 Workflow Features
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editorial productivity

Customizable Workspaces Access only the tools you need for a specific task or monitor configuration. Save 
panel layouts, keyboard shortcuts, and menu configurations as unique workspaces 
to fit the way you work. 

Customizable Menus Hide and colorize menu items to streamline workflows and simplify menus for 
more direct access to the commands you use most. Save these settings as part of a 
custom workspace.

Text Import from Word and Excel Adapt formatting of diverse Word and Excel documents as you import. Map Word 
styles to InCopy styles, and import or paste Excel spreadsheets as tables.

Text Variables Simplify and automate the use of repeating elements such as running headers, foot-
ers, product names, and date stamps. Modifying a text variable updates all instances 
of the variable throughout a document. 

Anchored Objects Anchored objects travel intelligently with a story as text flow changes. Quickly cre-
ate content such as sidebars and callouts that maintain position relative to a line or 
block of text.

Text Macros Accelerate entry of boilerplate text and other frequently used words and phrases. 
Type a short combination of letters and the shortcut automatically expands to the 
entire word or phrase.

Powerful Find/Change Quickly change text, text formatting, and object attributes in documents of any 
length. Customize the scope of a search to include master pages, footnotes, and 
locked or hidden layers. Save find/change queries for sharing and instant reuse. 
Speed complex searches by running one search using GREP, instead of running 
multiple conventional searches. 

Dynamic Spelling Flag misspellings, repeated words, and capitalization errors with inline markup as 
you type. Link specific text or styles to one of over thirty language dictionaries for 
foreign language spell-checking and hyphenation rules.

Built-in Thesaurus Use the Thesaurus panel to quickly look up synonyms, antonyms, and related 
words.

Advanced Bullets And 
Numbering

Make quick work of lists and numbered sequences, including figure numbers and 
advanced hierarchical sequences. Include bullet and number formatting in styles 
for easy global updates. Import bullets or numbering from Word documents. Use 
advanced hierarchical numbering, and continue the sequence over paragraphs that 
you don’t want to number.

Robust Footnotes Create footnotes or import Word text with footnotes preserved. Footnotes appear 
inline, adjacent to the footnote reference, for easy editing.

Robust Tables Creation and 
Formatting

Quickly create tables from scratch, import styled Word and Excel tables directly, or 
turn tab-delimited text files into tables. Format tables quickly and consistently with 
table styles.

Multiple Undo/Redo Step through your edits backward or forward in time. Undo/redo steps are unlim-
ited within the current session.

Position Markers Use position markers to quickly move back and forth between specific positions in 
your story without tedious scrolling and searching. 

Professional Typography Apply a wide range of precise typographic adjustments such as leading, letter spac-
ing, and paragraph spacing. Use OpenType fonts and Unicode character encoding, 
and easily apply glyphs by using the Glyphs panel.

Powerful Styles Create and easily update paragraphs, characters, objects, tables, and table cell styles 
for improved graphic and typographical consistency. Use style groups to simplify 
and organize long style lists.

Selective Style Import Selectively choose which paragraph and character styles to import from other docu-
ments, and easily specify how InCopy CS4 handles style-name conflicts.

Expanded Quick Apply Gain instant access to menu commands, styles, scripts, and text variables without 
leaving the keyboard for faster text formatting and editing.
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editorial productivity, continued

Glyphs Panel Enhancements Create typographically sophisticated documents with the enhanced Glyphs panel. 
New filters and the new Recently Used area streamline browsing and inserting 
glyphs from any font. Build and share glyph sets tailored to your workgroup’s needs. 

Expanded Scripting Support Use scripts to automate tedious work. Scripts can be created with JavaScript, Apple 
Script, or VBScript. Attach scripts to menu commands that run when the command 
is selected or launch a script from the Scripts panel. Support for compiled JavaScript 
protects your investment in building scripts. 

Robust XML Support Open, create, modify, and contribute structured XML text and tables to your pub-
lishing workflow.
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Appendix: InCopy CS4 and Microsoft Word Integration Features

•	 Import word processing documents into InCopy. Import plain text, Rich Text Format 
(rtf), or Microsoft Word files into checked-out frames in the layout. Use controls in the 
Import Options dialog box to customize the conversion of text formatting, tables, and 
page breaks. Save settings in a preset for future use. 

To facilitate working with outside contributors, InCopy CS4 makes it easy to import and convert  
the formatting in Word documents.

•	 Share InCopy stories with Word users. Export any story in a layout or assignment to rtf 
compatible with Word, to share with outside authors who aren’t part of the workflow. 
Place incoming rtf files into checked-out layout stories.  

•	 Open text files directly in InCopy. Open Word (doc) files, ascii (txt) files, and Rich 
Text Format (rtf) files using the File > Open command. A conversion dialog box 
appears with options dependent on the file type being opened. After choosing options 
and clicking OK, files are converted to standalone InCopy (.icml) files. 

•	 Import selected text from Word. Drag and drop or copy and paste text selections from 
a Word document directly into an InCopy story. Choose whether or not InCopy should 
retain the original formatting in the InCopy Preferences dialog box. 
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FOR MORE INFORMATION

• InCopy CS4 free trial and documentation  
Download a free trial of InCopy CS4 for 
Macintosh or Windows© from the Adobe 
website. Free trials are fully enabled for thirty 
days and come with full documentation built 
into the program’s Help files. 

• InCopy CS4 + InDesign CS4 Integration  
This comprehensive video tutorial series (over 
eight hours total) authored by independent 
InCopy trainer and consultant Anne-Marie 
Concepción can be purchased on DVD or 
viewed online at http://lynda.com.

• InCopyFlow 
Free monthly e-zine of InCopy workflow 
tips, techniques, news, and reviews for edi-
tors and designers who collaborate in the 
workflow. Sign up at http://senecadesign.com/
designgeek/incopy.html.

• InCopy User Forum 
Visit the InCopy user forum to get answers to 
technical questions or exchange ideas with 
other users. http://www.adobe.com/support/
forums/.

• InDesign User Group 
Learn more about InCopy, get the latest 
InCopy and InDesign news, and con-
nect with other InCopy users. http://www.
indesignusergroup.com/.

Summary

For thousands of small to midsize editorial workgroups, the basic InCopy CS4/
InDesign CS4 workflow enables tight collaboration, accurate page visualization, and 
significantly enhanced productivity. It provides many of the efficiencies of high-end 
editorial systems at a fraction of the cost and without imposing the strict procedures 
they demand.

Whether you work on the editorial, design, or business side of publishing, and whether 
you publish books, magazines, newspapers, catalogs, brochures, or nearly anything 
else, if you’re looking for a flexible, streamlined workflow solution for your publishing 
team, we encourage you to learn more about integrating InCopy into your workflow. 
Visit the Adobe web site at www.adobe.com/products/incopy/ for detailed product 
information or to download a 30-day trial version of InCopy CS4 or InDesign CS4. 
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